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Preface

SigCal was written to make the process of calibrating speakers and using
normalization files with SigGen an easy matter.  One of the keys to
successful calibration is knowing the limitations of hardware, and how to
avoid common pitfalls.  These are briefly described in this manual.  For
more information you should refer to the guide ‘DSP Applications Using
System II’, which can be found in the System II manual.

We hope you will find this software friendly and useful.  As always, we
welcome your comments on how to improve our software to make it more
useful for your research.
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Organization of the Manual

� Chapter 1   Introduction
Installation of SigCal and hardware configuration.

� Chapter 2   SigCal Overview
An overview of the windows and menus in SigCal.

� Chapter 3   Using SigCal
Instructions on how to use SigCal to calibrate your speaker and generate
normalization files for use with SigGen.
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Chapter 1   Introduction

What Is SigCal?
SigCal is designed to make speaker calibration and generation of SigGen
normalization files a simple process.  SigGen normalization files can be
used to flatten non-linear frequency responses of speakers.

SigCal Capabilities
SigCal will play out a series of tones and measure the sound pressure level
(SPL) from a signal from a calibrated microphone that is digitized by an
A/D converter.  SigCal will then automatically calculate a normalization file
that maximizes the signal to noise ratio of the D/A converter, while avoiding
clipping.

Hardware Support
SigCal supports TDT’s System II instrumentation, including any
combination of TDT’s D/A and A/D converters.   The D/A and A/D can be
triggered either from software or from the TG6 timing generator.

Before You Begin

What You Need

See your Microsoft
Windows
documentation.

See the SigGen
manual.

+ Windows fundamentals

You should be comfortable with Windows basics:  starting Windows;
using the mouse; manipulating windows; opening, closing, and saving
files.

+ Basic SigGen concepts

If you are going to be using SigCal with SigGen, you should be familiar
with generating SigGen signals using the Frequency method.
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Installing the Software

Requirements
In order to run SigCal, you must have the following:

� Microsoft Windows 95

� A monitor with at least VGA resolution graphics.  Super VGA
(1024 x 768) resolution graphics highly recommended

� TDT’s AP2 Array Processor

� TDT’s XBUS hardware including

• D/A converter

• A/D converter

• TG6 timing generator (optional for trigger D/A and A/D)

� Speaker

� Calibrated microphone and microphone amplifier

Installation

To install SigCal

1. Make sure your TDT hardware (including AP2 Array Processor
and XBUS devices) is installed and functioning properly.

Refer to the System II Installation Guide.

2. Insert the SigCal diskette into drive A: or B:.

3. Run setup.exe to start the installation program.
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Hardware Configuration
SigCal can trigger sound presentation and data acquisition either from
software or from hardware with a TG6 Timing Generator.  You will
have to connect the rest of your system the same way that you will be
using it with your other software.  Use the same filter, attenuator, and
amplifier settings that you would normally use.

Software Triggering

The D/A will be triggered by software.  If you use a DD1 or PD1, no
hardware connections need to be made.

If you have separate D/A and A/D modules, then the SYNC output of
the D/A needs to be connected to the TRIG input of the A/D module.

0LFURSKRQH
$PS

$PSOLILHU�	�7UDQVGXFHU

TG6 Triggering

The D/A and A/D can also be triggered by the TG6.  Channels 1, 2, and
3 of the TG6 will send out simultaneous trigger pulses, and these can be
connected to the TRIG inputs of the D/A and A/D as desired.  The
standard SigGen Solutions configuration with TG6 channel 2 to the
D/A TRIG and TG6 channel 3 to the A/D TRIG input will work, so that
you don’t have to change connections between programs.

0LFURSKRQH
$PS
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SigCal Plots
The Time Waveform shows the time domain plot of the recorded
signal.

The Power Spectrum shows the frequency domain plot of the recorded
signal.

The Calibration plot shows the speaker calibration, normalization
curve, normalization curve test data, and total harmonic distortion
(THD) measurements.
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File Menu
The file menu has commands for opening and saving SigCal files.
SigCal files have the .cal extension.  SigCal files contain all of the
SigCal settings as well as the data for SigCal files that have been run.
Note that the functions to export normalization files and to export
calibration data to an ASCII file are found under the Calibrate menu.

New
Opens a new SigCal file with no calibration data.  Previous SigCal
settings are maintained.

Open/Save/Save As
These commands will open and save all of the settings and calibration
data in a  SigCal file.  The most recent SigCal files are shown at the
bottom of the File menu.

Print/Print Setup
These commands will setup printing of the current SigCal screen.  The
size of the plot on the printer is directly proportional to the size of the
SigCal window.  So, to increase the size of the plot, maximize the
SigCal window.

Exit
Exits the SigCal program.
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SetUp Menu

Signal

Overview

Use this dialog box to setup the calibration tone voltage and frequency
series.  The frequency series can be set through the Manual Frequency
Settings or by using a frequency variable from a SigGen file.

Tone Volts (peak)

The peak voltage (i.e. not rms voltage) of the calibration tones.  The
D/A have a maximum peak voltage of 10V.  This value is used for
generating the test signals for either the Manual Frequency Settings or
SigGen Frequency Settings.

MANUAL FREQUENCY SETTINGS

These settings are used to produce a series of tones whose SPL will be
measured.

Frequency Start

The first frequency of the calibration tone series.

Frequency End

The last frequency of the calibration tone series.
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Frequency Step

The step value used to generate the tone series.  The tone series may
consist of a maximum of 1000 frequencies.

If Multiplicative Step is not checked, the value is a linear step.  For
example, if Frequency Start is 1000, Frequency End is 10000, and
Frequency Step is 1000, the frequency series will be: 1000, 2000, 3000,
…, 10,000.

If Multiplicative Step is checked, the value will be used as a multiplier.
For example if Frequency Start is 100, Frequency End is 6400, and
Frequency Step is 2, the frequency series will be:  100, 200, 400, 800,
1600, 3200, 6400.

Sample Rate (µs)

The sample period for the D/A and A/D converters.  The maximum
frequncy that may be used for the frequency series is one-half of the
sample rate.  For example, for a sample period of 20 µs, which
corresponds to a 50 kHz sample rate, the maximum frequency that may
be played is 25 kHz.

SigGen Frequency Settings

A frequency series may also be specified by loading a SigGen Signal
and choosing a variable that contains the values of the frequencies you
want tested.
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It is important to note that the SigGen signal will not be used in the
calculation. Instead, a series of tones will be generated with each tone’s
frequency specified by a SigGen variable.  The amplitude of the tone is
set in the Tone Volts edit box in the Manual Frequency Settings section.

When a SigGen file is used the manual settings that can not be adjusted
are grayed out.  The sample rate is set to the sample rate specified in the
SigGen file.  The start and stop frequencies are determined from the
SigGen variable and listed in the manual settings section.



2-6 SetUp Menu

Acquisition

Overview

The Setup Acquisition dialog box is used to configure the A/D
converter, configure options for averaging, and to set the microphone
calibration and gain.

# Averages

Enter the value for the number of sweeps that will be acquired and
averaged to obtain the calibration measurement.  More sweeps will
reduce the influence of background noise that is not produced by the
transducer.

Drop First Sweep

Check this box to drop the first sweep and not include it in the overall
average.  Since the D/A and A/D start converting simultaneously, the
time it takes the signal to reach the microphone will be recorded as no
signal, if the first sweep is included.  By dropping the first sweep, the
effect of this travel time on the calibration value is minimized.

AC couple

Check this box to remove any DC shift from your signal.
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FFT Points

This is the number of points used by the inverse FFT to generate the
signal and the number of points used by the FFT to calculate the power
spectrum.  A larger number of FFT points will produce a longer test
signal with greater frequency resolution.

Microphone Calibration

Enter the value for the microphone calibration here as the number of
millivolts produced by the microphone for a given SPL.

Microphone Gain

Enter the amount of gain on the microphone before the signal is sent to
the A/D converter.  Do not enter any gain that is already accounted for
by the microphone calibration you entered.

The gain value may be specified as either linear by checking ‘x’ or as
logarithmic by checking ‘dB’.  For example a value of 100 with ‘x’
checked corresponds to 100x gain.  A value of 100 with dB checked
corresponds to 100 dB gain.
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Calibrate Menu
Once the calibration signal and acquisition have been configured,
choose Start from the Calibrate menu.  SigCal will play the series of
tones and automatically generate the calibration curve, and SigGen
normalization data.

Start
Starts playing of the calibration tone series and acquisition and analysis.
While calibration is in process, the signal values can not be changed.
Press stop before changing any settings.

Stop
Stops calibration procedure.  If a calibration series is not complete,
there may be invalid data for the rest of a series.  When generating
normalization files, be sure to run the calibration through the entire
frequency series.

Test Norm
Runs through calibration series and applies the normalization data to
the calibration tones.  This allows you to test whether the normalization
file will work in SigGen.  The dotted lines produced by the test
normalization series should be close to the green normalization line.

Iterate
Runs through the calibration series and applies the normalization data
to the calibration tones.  The normalization data will then be adjusted to
account for any deviations from the normalization line.  Iterate may be
run several times in a row to try to improve matching to the
normalization line.

Autoscale
Autoscale will scale the left hand y axis to the minimum and maximum
of the calibration curves.

Save Norm
Saves normalization data to a SigGen normalization file (*.nrm).
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Export Calibration Data
Saves calibration data to an ASCII text file that may be imported to a
spreadsheet.  The calibration data includes the SigGen calibration
value, the calibration without normalization calculated from both the
time signal and power spectrum. The total harmonic distortion
measurement, and the normalization curve. If a test normalization is
run, these data are also saved to the data file.

Export Raw Data
Saves raw data from time signals and power spectra from all of the
frequencies tested to two separate files.  The time signal data are saved
as volts and the power spectra as dB SPL.  It takes several seconds to
save the data, be patient.  A maximum of 100 time and frequency
buffers may be saved.  If more frequencies were tested, only the last
100 will be saved.

Save SigGen File
If a SigGen variable is used to generate the tone frequency series, the
calibrated value determined by SigCal may be saved to that SigGen file
or a new SigGen file.  For example, if SigCal determines that 9.0 V =
105.5 dB.  This calibration may be saved to the SigGen file by choosing
Save SigGen file.  This would modify the calibration values that you
see in the SigGen Signal dialog box (opened by choosing Signal from
the Modify menu in SigGen).

Save Variable Schedule File
SigCal will save a variable schedule file that contains two variables:
Freq and CalAtten.  This schedule file can be used to calibrate a
frequency series in SigGen through the use of a programmable
attenuator.  It is not useful for non-tonal signals, like noise.  The
schedule file will list each frequency tested and the amount of
attenuation needed to calibrate that frequency.  The schedule file will
also contain header information about the calibration values that should
be set in SigGen (note: these will not be set automatically), and the date
and time the schedule file was saved .
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View Menu

Time Signal SPL
When checked, plots the SPL measured from the time domain signal in
yellow.  This SPL measurement will often be higher than the SPL
measurement from the power spectrum (shown in blue) due to
background noise outside the frequency band measured.

THD
When checked, the THD values are plotted as brown squares on a scale
of 0 to 5%.  If Normalization Curve is also plotted, the THD scale will
not be shown.

Normalization Curve
When checked, the normalization data that are applied to the test signal
are plotted as a purple line.  The y scale for the normalization curve is
shown on the right and is automatically scaled.

Toolbar
Shows the toolbar.

Status Bar
Shows the status bar.

Screen Controls

Zooming the time and frequency
plots
Zoom in on a plot by clicking on the left mouse button and dragging to
the right.  To zoom out, click on the right mouse button while it is in the
plot area.

Zooming the calibration plot
The dB SPL scale may be manually zoomed out by left clicking in
either the upper or lower part of the scale to change the maximum and
minimum plot values.  Right click in the scale to zoom in on the plot.

Autoscale may also be used to automatically scale the plot.
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Moving the normalization line
The green normalization line may be moved by left clicking on it and
dragging it to a new position.

Inspecting individual frequencies
To inspect the time and frequency plots of different frequencies, right
click in the calibration plot on the frequency you wish to view.  The
current frequency being displayed is shown in the upper right hand
corner of the frequency plot.  Only the last 100 frequencies tested are
stored in memory.

Toolbar
The toolbar has shortcuts to all of the menu items.  Place the mouse
cursor over a toolbar item for information on its function.
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Calibration Fundamentals

TDT D/A Converter
It is important to understand how the TDT D/A converter (DAC)
generates signals and how to best take advantage of the DAC for high
signal quality.  The DAC can generate a maximum signal of +/- 10V
peak-to-peak.  This signal is generated digitally with 16-bits, meaning
there are 65536 discrete values that the DAC can generate.  This gives
the DAC about a 96 dB theoretical dynamic range between the smallest
and largest signal that can be produced.

It is best to try to generate the largest signal possible out of the D/A.
This will give you the best signal to noise ratio, and also lets you take
advantage of the full dynamic range of the DAC.  Chapter 1 of DSP
Applications using System II in the System II manual has a complete
technical discussion of this issue.

Signal to Noise Ratio

All electrical systems have some level of noise in them.  The noise
coming out of the DAC is the same whether you are generating a 9 V or
a 9 mV signal.  Therefore, the signal to noise ratio of your signal will be
higher the closer you get to the 10V maximum of the DAC.

Clipping

If you try to generate a signal larger than 10V, the DAC will clip the
signal.  That is, the peaks of the signal that exceed 10V will be set to 10
V, and your signal will not be faithfully reproduced.

How normalization files work
The purpose of normalization files is to flatten the frequency response
of the speaker by adjusting the voltage of the digital signal that is
played out of the D/A converter.  In SigGen, the normalization curve is
added to signals generated in the frequency domain to produce the
normalized time signal, which is then played.

Since the dynamic range of the DAC is 96 dB, this is the theoretical
maximum range that a normalization curve could have before there was
clipping or no signal was produced by the D/A.  However, if you
normalize down 90 dB, that only gives you 6 dB worth of dynamic
range.  A tone could then only be made with a handful of discrete
values, and its quality would be diminished.  Thus, it is best to
normalize over a smaller range of the DAC, around 20 dB.  SigCal has
built in warnings for indicating that a signal will clip or be too small.
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Using a PA4 Programmable
Attenuator to Calibrate a Tone Series
If your SigGen signal consists of a single tone where the frequency may
vary over separate SGI’s, then you could use a PA4 to calibrate your
signals instead of a normalization file.

The advantages of using a PA4 for calibration include:

• You can use either the Time of Frequency methods of signal
generation in SigGen.

• The signal-to-noise ratio of all of the frequencies tested will be the
same.

• You can play a large signal out of the DAC and use the wide
dynamic range of the PA4 to calibrate the signal over a larger
range.

SigCal will generate a Variable Schedule File containing values that
should be sent to the PA4 at each frequency to calibrate the signals.
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Configuring Signals and Acquisition

Signal Setup
Open the Signal Setup dialog from the Setup menu to configure the
range of frequencies that will be tested.  The default test level is 9 V to
maximize the dynamic range of the DAC.  Set the start and stop
frequencies to cover the entire range that you will want to use.  Use a
large step value for a quick first run to see how flat the speaker is over
that frequency range. This can later be set to a smaller value to produce
the normalization file.

Acquisition Setup
For the initial run, use the default settings.  This will allow you to
quickly estimate how flat the speaker is.  For the final run, you can
increase the number of averages and FFT length to get a more precise
calibration.

Enter the microphone calibration for your microphone and amplifier.  It
is important that you have a microphone with a known calibration.  The
accuracy of the calibration depends on the accuracy of the microphone.

Running the Calibration
Once the signal and acquisition are configured, make sure the TDT
hardware is configured as you will use it in your experiment.   Connect
the DAC to the amplifier and speaker that will be used in your
experiment.  Connect the microphone to the microphone amplifier and
then to channel 1 of the A/D converter.  If you are using a TG6 to
trigger the DAC and ADC, connect the TG6 to the TRIG inputs on the
DAC and ADC.  If you are not using a TG6, connect the SYNC of the
DAC to the TRIG of the ADC.  There is a diagram in Chapter 1
illustrating these connections.

Run the Calibration
To start the calibration, choose Start from the Calibration menu, or
click on the Play button on the toolbar.  The calibration may be run
several times if you need to adjust the speaker amplifier, microphone
amplifier, or experimental setup.
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Setting the Calibration Level

The calibration level is the value that will be used to calculate the
normalization curve.  It is represented by a green line on the calibration
plot.  If the SPL at a given frequency is greater than the calibration
level, this will result in a negative normalization value.  Likewise, if the
SPL is less than the calibration level, this will result in a positive
normalization value that will be added to the signal to boost it so that it
equals the calibration value.

After the calibration is run, the calibration level will be automatically
set as high as possible so that the resulting normalization curve does not
produce clipping in the DAC when it is used in SigGen.

The calibration level will give you the calibration value to use in
SigGen.  For example, if a 9V test signal was used, the calibration may
say 9V = 110 dB. As you adjust the line, you will see this calibration
value change.

Changing the Calibration Level

In most cases you will find that the calibration level is set just as you
need.  To change the calibration level, left-click on the green calibration
line and drag it to a new value.  A new normalization curve will be
calculated based on the calibration line.
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Clipping

If you set the calibration level too high, so that the normalized signal
would be clipped (i.e. the normalization curve would cause the signal to
be larger than 10V), red squares will be placed on the calibration curve
at frequencies that will be clipped.

Too Much Attenuation

If you set the calibration level too low, so that the output signal would
be less than 0.1 V (giving a dynamic range of 56 dB), green squares
will be placed on the curve.

Viewing the Normalization Curve

To view the normalization curve, select Normalization Curve from the
View menu.  The normalization curve will be autoscaled so that it is
maximized on the plot.  The scale for the normalization curve is labeled
on the second y axis.
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Testing the Calibration
Once the calibration has been run and the normalization curve
generated, you can test the normalization curve.  Select Test Norm from
the Calibration menu.  This will use the normalization curve to adjust
the signal produced by the DAC.

The level of the sound will be plotted as a dotted line.  If the
normalization curve is set properly, the dotted line should closely
parallel the green calibration line.
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Fine Tuning the Calibration
If the calibration test shows that the normalization curve does not
produce a flat response out of the speaker:

1. Check to make sure that you are not overdriving the speaker.  Look
at the THD levels and the power spectra to make sure that you are
getting a pure tone signal, and not a lot of harmonics.  If you see a
lot of harmonics, you either should turn down the gain on your
speaker amplifier, or attenuate the signal from the DAC by sending
it through a PA4 Programmable Attenuator.

2. Make sure that the microphone is not being overdriven, and that the
amplitude of the signal coming out of the microphone amplifier is
at least one volt (look at the voltage on the Time Domain plot), but
not more than 10V.

3. Try iterating the normalization test several times.  This will adjust
the normalization curve based on the deviations from the
calibration level.

4. Try re-running the entire calibration with more averages and/or a
longer FFT.

If you can’t get one normalization file that covers the whole frequency
range of the speaker without either clipping the signal or playing too
small a signal out of the DAC:

1. Break your frequency range into two parts, and create a
normalization file for each section.

2. You will also have to create a separate SigGen file with a different
calibration for each section.

Saving the Normalization File for use in
SigGen

Once you have established the reasonable frequency range to use for
your speaker, run the calibration with smaller steps, and test it.  When
you are satisfied that the normalization file produces a sufficiently flat
response, save your normalization file by selecting Save Norm from the
Calibration menu.

The file can then be used in SigGen by checking Use Norm in the
Signal Parameters dialog box (opened by selecting Signal from the
Modify menu), and then loading the normalization file.

Be sure that you are generating signals using the frequency method
in the segment dialog box.  Otherwise, the normalization file will
not be used.
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Remember to change the calibration setting in SigGen to the value
determined by SigCal. If a SigGen variable is used to generate the tone
frequency series, the calibrated value determined by SigCal may be
saved to that SigGen file or a new SigGen file from SigCal.  For
example, if SigCal determines that 9.0 V = 105.5 dB.  This calibration
may be saved to the SigGen file by choosing Save SigGen file.  This
would modify the calibration values that you see in the SigGen Signal
dialog box (opened by choosing Signal from the Modify menu in
SigGen).  If you did not use a SigGen file to set up the frequency series,
you would have to manually enter this calibration in SigGen.
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Calibration of Tone Signals
Normalization files are of most utility for non-tonal signals.  If you are
using single tones as your SigGen stimuli, then you will obtain better
signal quality if you use the PA4 Programmable Attenuator to equalize
the different frequencies.  SigGen Normalization files adjust for the
transducer variability by decreasing the signal amplitude output by the
D/A.  When tones are used, since you are only playing one frequency,
you can use the PA4 to adjust the signal level.  This will provide
constant signal to noise ratio for all of the frequencies and let you
maximize the output voltage on the D/A converter.

Use the Save Variable Schedule File feature of SigCal to save these
values to a variable file for use in SigGen.  The values saved to these
files will be the attenuations that need to be applied at each frequency to
calibrate the signal.  In SigGen use this variable file to attenuate each
frequency appropriately as shown in the example below.

Using a Variable File in SigGen to
Calibrate Tones
In this example one wishes to use five different frequencies in a tone
pip experiment.  However, each tone is calibrated to account for
transducer variability across frequency.  The tones we want to use are
listed below:

Frequency Transducer Sensitivity Attenuation Setting

1000 Hz 98.0 dBSPL/vrms 8.0

1400 Hz 96.5 6.5

2000 Hz 93.8 3.8

2700 Hz 92.0 2.0

3500 Hz 91.1 1.1

To get the tone pips to play out at a calibrated level we need to
attenuate the low frequency tones so that they match the level of the
highest  frequency tone.  The last column shows some attenuation
settings that could be used to normalize the transducer to have a
uniform sensitivity of 90.0dB SPL/vrms.  These will be calculated for
you by SigCal.

The variable file produced by SigCal has the information for both
frequency and the corresponding calibration attenuation:

{

Freq
1
1000
1400
2000
2700
3500
}
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{

CalAtten
1
8.0
6.5
3.8
2.0
1.1
}

In SigGen32 make a variable called PipSel that goes from 1 to 5, which
will be used as the SGI modifer.  For example, if we want to do a
frequency intensity series we need another variable called Level that
steps through the levels we want.  Then nest these variable as was done
previously with SigGen.

Now make two variables called Freq and CalAtten both using the
variable file above as their source.  Under SGI modifiers select the
PipSel variable with a scalar of 1.0.  These variables will then use the
value of PipSel to pick which frequency and attenuation to use.

Now click preview variables and at the bottom on the screen click the
combined values button.
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